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1. Introduction 
Quefax is a system of research data management that uses Word document forms to capture field data 

and a relational database to maintain and make it available for analysis. The database is generated 

automatically from the form; so is the data transfer from the form to the database. This is made possible 

by (a) marking up the form using the Extended Markup Language (XML) and (b) re-using the Logbook 

software (Muraya & Garlik 2001). 

Quefax was designed to cope with the complexity of data management encountered in the Sub-Saharan 

Africa Challenge Program (SSA CP). In this program data were collected at multiple levels: plot for 

biophysical measurements, household and village for socio-economic conditions. The data collection 

instruments were collaboratively designed by a team of close to 100 scientists of different disciplines, 

spread out throughout Africa and not all of whom had good internet connection. A key requirement for 

this program was that data collected for the baseline conditions, for monitoring and evaluation and for 

assessing impact at the end of the study must be all so managed that was analyzable as a consistent set. 

Furthermore the data management system needed to accommodate data, outside of the common 

variables, that were unique to some regions.  

Against this backdrop we needed a system that ensured that the collected data would be:- 

(a) of good Quality 

(b) Processed Efficiency 

(c) Accessible and understandable all the time 

(d) Documented as far as possible 

This manual documents Quefax in 3 parts. The targets for part 1 are the data enumerators who are 

responsible for data collection, entry and cleaning; part 2 is for the scientists who have to pre-process 

the data prior to the formal analysis; and part 3 is for the data managers who need to have enough 

database skills to setup Quefax and support both the enumerators and users. 
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2. Part 1: Data Operators 
This section for data operators is organized to follow the data life cycle as illustrated in Figure 1  

 

Figure 1: Data Life Cycle 

The style used is to present as much instructions as needed by someone to operate Quefax after it has 

been properly setup. All Quefax installation details are referred to part 3 for data managers. 

The last stage, data archiving, is not covered in this manual. Quefax was designed to ensure that the 

metadata needed for accessing and understanding the data in the long-term are captured during the 

preceding stages, i.e., not when the project ends. 

1.1  Data Planning 
Setting up Quefax is the work of data managers, and is covered in part 3. For data operators, planning to 

use Quefax means simply identifying computers on which Quefax has been installed, and being able to 

access the data management tools. There are two signs to look out for:  

(i) The Logbook sub-menu in the Windows Start/All programs menu and  

(ii) The Quefax folder which should organized as illustrated in Figure 2.   

 

Figure 2: Folder structure of a Quefax Installation 

Check with your data manager absolute location where Quefax is installed; in this manual were will refer 

to this folder as <Quefax> 

1.2  Data Acquisition 
You are ready for data acquisition if you have identified a Quefax computer (i.e. one in which Quefax has 

been installed successfully); then take the following steps 

(i) Create a new dataset folder or select an existing one.  

Data 

Planning
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Utilization

Data 
Archiving
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(ii) Create or select a data entry template for dataset 

(iii) Use the template to create an electronic form (i.e. e-form) 

(iv) Enter the data using the e-form 

(v) Save the filled-in e-form 

The first 2 steps -- creating data entry templates and dataset folders – are covered in part 3; here we use 

the sample datasets to illustrate the last 3 steps. 

a) Select the dataset if you have one. If not, select the one named “Conservation agriculture” in 

folder <Quefax>\Sample datasets\Conservation agriculture household survey. Generally this 

folder will be called the <dataset folder>  

b) In the Work sub-folder open the word document template named Household survey.dotx 

c) Double-click on the template to create a new document (Do NOT right click to open it as this will 

modify/edit the template instead of cloning it). The new document is called e-form. 

d) Transfer the data recorded on the printed paper to e-form. This step should be straight forward 

because the e-form should be identical to the hard copy equivalent – if the paper version was 

printed from the same template as the e-form. This means that there should be less data 

transcription errors than in alternative scenarios and the time to train data entry people (as well 

as the required computer operation skills) are minimal. 

e) Save the e-form to <dataset folder>/e-form folder using a systematic naming pattern. In the SSA 

CP program we used <dataset name>xx.docx where xx was a unique number for each 

questionnaire. We found that using the same number on the hard copies was very helpful. 

1.3  Data Maintenance 

Data maintenance in a Quefax setup involves 3 activities. 

i. Getting a database that match the dataset 

ii. Updating the database using e-forms 

iii. Cleaning the data 

Each dataset has a database associated with it. Section 1.11 explains to data managers how to create 

one. In this section we assume you have access to an existing one. This may be one already created by 

the data manager for your project, or the one located in <Quefax>\sample datasets\conservation 

agriculture\work\household survey.mdb 

 Take the follow steps to update the database 

a) Open the database 

b) Call the Logbook 

c) Use the Logbook to load the e-forms 

Updating database 

When the Logbook is called and an Access database is open, it will lock onto the database. If there are 

many open databases, it locks onto the first one – which may not be the one you want. So, make sure 

that there is only one copy of database running before you call the Logbook. 
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Logbook provides 2 methods of loading the e-forms: one e-form at a time or many e-forms in a batch. 

To load a single e-form, open it first; then click on Logbook’s Update database menu, followed by the 

Using current e-form sub-menu. 

The batch mode for updating the database requires the use of an Interface Workbook to specify a 

number of input parameters, one of them being the location of the e-forms. Section 1.12 explains how 

to modify the Interface Workbook for batch loading to fit your situation. 

The default method for reporting errors is that the loading stops and the user respond to the error. This 

is called the attended mode of error reporting. The preferred mode for error reporting errors while 

loading e-forms is unattended, so that errors are instead logged into a file. Follow these steps for batch 

loading. 

a) Get an Interface Workbook for batch loading your dataset 

b) Set to unattended mode by clicking on the File menu, followed by the Set unattended mode sub-

menu. 

c) Click on the Update Db menu, followed by the Using current workbook submenu. 

d) Inspect the error log and, if there are errors, re-act to them. The error log file is in 

C:\logbook_error_log.xml. Its structure is documented in appendix 1.13 

The use of e-forms is a structured means of updating the database; there are other less structured 

methods, such as adding new fields to the databases and capturing variables directly, capturing data 

in spreadsheets then uploading it, etc. Quefax defines this as more a role for the data manager than 

for the data operators.   

Cleaning data 

It is much easier to clean the data after it is loaded into the database than when it is in e-forms. To 

synchronize changes in the database with those on e-forms, Quefax uses the following steps to 

effect data cleaning. 

i. Select the variables for cleaning. Section 1.5 covers this in more detail  

ii. Use one of many approaches (visual inspection, data type consistency, range checks, 

graphical plots, etc)  to detect errors 

iii. Investigate their causes. The simple errors could be “tips of an iceberg” 

iv. Retrieve the erroneous e-forms.  

v. Correct them 

vi. Update database using the corrected e-forms 

vii. Suggest changes in field practices, questionnaire design, or Quefax system that could 

minimize chances of further occurrences of similar errors   
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1.4  Data Utilization 

Quefax expects that data operators will have database querying skills, specifically the Structured Query 

Language (SQL). There are many tutorials available in the internet. In addition they will need to 

understand the model that was used to create the relational database used for data maintenance.  The 

following sections of this manual will assume basic knowledge of relational databases, but it will cover in 

detail those aspects that are unique to Quefax.  
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3. Part II: Data Users 
Data users are typically performing the following tasks:-. 

i. Querying the database 

ii. Presenting the results 

iii. Exporting the results outside of the database to statistical software for formal analyses 

1.5  Querying the Database  
To use a Quefax database effectively you need to understand how structure of the database that is 

related to the structure of the template from which it was generated; then the template becomes useful 

for selecting data from the database. This section assumes that the user:- 

 Knows what variables to select 

 Can locate them easily on the template 

 Has the Developer menu in Microsoft Word 2007 available 

 Can use the query design view of Microsoft Access to select data 

Understanding the Quefax data model 

The general Quefax data model comprises of one parent table and 0, one or more child tables linked by 

a one-to-many relationship. This means that one record in the parent can be linked to many records in 

the child table, but one child table can only link to one parent table. For example, if the parent table is 

Country and the child table is Person, then a country can have many people, as expected. The one-to-

many relation forbids dual nationality. In the SSA CP the primary tables derived from the major types of 

surveys conducted: Households, Villages, Traders, Plots and Innovation Platforms. For each primary 

table, there were as many child tables as there were in the questionnaire. It is during the process of 

creating a template, section 1.10, that the parent and child tables are marked. The names given to 

tables and fields in the database are read directly from the template.  

 

Selecting data 

The Quefax databases from the SSA CP work had many child tables, some of them with few fields, other 

with very many fields (See Table ). You therefore need to focus on a few variables. Select them, one at a 

time; then join them for further presentation. This would be easy if the only a few tables and fields were 

concerned, otherwise you need a systematic way of navigating from the template to the database tables 

and fields. The procedure is as follows:- 

i. Start from the template that was used to create the database 

ii. Copy it, to create a working version, and open the copy 

iii. Unprotect it, to allow changes to the template. See further help on how to do this in Word 2007. 

iv. Find (and move to) the variable of interest 

v. Use the XML panel of Word 2007 to get the names of the field and the associated table 

vi. Use the names to query the database  
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Table 2: Structure of the a complex questionnaire 

Tables of the Household Questionnaire in the SSA CP 

Title of the Table Table Name No. of 
fields 

***Household Baseline Survey household 53 

Marketing strategies and linkage with agricultural traders strategies 18 

Land Holding in Hectares / Acres acreage 13 

Sale of Livestock products products 12 

Most recent interactions interactions 12 

Use of soil conservation and other land management options agriculture 11 

Use of Post Harvest Technologies harvest 11 

How many livestock does this household own now? livestock 11 

Saleof Livestock sales 10 

If yes, which groups and what are their main activities? activities 10 

Equipment equipment 10 

Evaluation of Existing interactions and approaches: evaluation 10 

General access to inputs inputs 10 

If Yes, who provided the training, what was the topic and how would you rate it? (up to a 
maximum of 5) 

training 9 

What are your priority sources of income and what is the income estimate from these sources 
for the last 12 months? 

income 9 

Constraints to marketing market 8 

If yes, which were the months in the last 12 months that you did not have enough food to meet 
your family’s needs? 

food 8 

What kinds of assistance or information were requested? Tick where appropriate assistance 8 

Household Food Security foodsecurity 7 

Household dietary diversity dietary 7 

Access to credit credit 7 

WELFARE INDICATORS indicators 7 

Collective Marketing and other group activities marketing 7 

Access to market information access 7 

Interactions with other farmers and farmer groups farmers 6 

Coping with food shortages mechanisms 6 

If yes, complete the following table participation 5 

 

 

Getting field and table names 

In the template the names of tables and fields are captured in XML attributes. Use the following steps to 

find the table and field names for a selected variable. 

 

(a) On the template point to the title of the variable of interest 
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Table 3: Identifying raw data in the questionnaire 

 

(b) On the Developer tab, click on Structure in the XML group to open the XLML structure pane. Click 

on the desired variable i.e. Total Note that the title element in the XML structure pane is 

marked.  

This is one of the variables required 

for output.  How do you locate it in 

the database? 
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Table 4: Switch on the XML pane to show the XML structure of the questionnaire 

 

(c) Move up the tree structure to locate the Variable element that is a parent of the title element.  

Point to the variable to reveal the name attribute 
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Table 5: Accessing the name attribute of a variable element. XML pane A shows a variable that is part of 

a child table. B shows a variable that is part of the parent table. Note that the immediate parent node 

for a child table variable is the columns element. That of a parent table is the field element. 

  

(d) Find the table names 

Find the table name associated with a variable depending on whether the associated table is the 

parent table, or one of the child tables. For a child table, get the parent element of columns. It 

should be a table element. Pointing to it will reveal the name attribute.  

For a parent table, go to the root node of the document. It is the questionnaire element. You reveal 

the name by pointing to the element. 

Querying the database 

 

Once the field and table names of the desired variable are known, you query the database following 

these general steps. 

1) Open the database 

2) Create a query 

3) In the query design view, add the named table 

4) From the table, select the named field 

A 
B 
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Basic database querying steps 

Child table name 
in the database

Desired variable 

 
Other variables under the landholding can be added to the grid below as required. You then need to 

switch to the Datasheet View to checks on the results as recorded in the database. The criteria row 

is used to set conditions to for summaries, totals, sorts etc. 

In some cases some variables need to be converted from text to numeric for further computations. 

To do the conversion, under criteria type the following expression. 

 

IIf(IsNumeric([landholding.total]),Val([landholding.total]),Null) 

 

This will convert all entries under variable name total in the landholding table returning a blank if 

there is no entry. 

 

1.6  Presenting Data 

1.7  Exporting Data 

Using Open Database Connectivity (ODBC) 

ODBC is a widely accepted application programming interface (API) for database access and uses 

Structured Query Language (SQL) as its database access language.To set up ODBC on your access 

database: 

1. Click the Start menu, point to Settings, and click Control Panel. Then 
Administrative Tools"  to find Data Sources (ODBC) 

2. You'll probably find that the dialogue defaults to "User DSN". Make sure 
that you select the "System DSN" tab and click "Add". 
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3. Select the Microsoft Access Driver, and click Finish. 
4. In the ODBC Microsoft Access Setup dialog box, give an appropriate 

name for the Data Source Name.  
5. Navigate to the database provided by the ASP Web Wizard 2000 on your 

hard disk , select then click OK. 

Setting up an ODBC connection to your database

1
2

3

4

6

7

5

 

Figure: Sequential steps involved in setting up ODBC  
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4. Part III: Data Managers 
This part is for data managers, i.e., people who have to setup and support the Quefax system. After 

reading it, the data managers should be able to:- 

a) Prepare a new computer to work with Quefax 

b) Create Quefax datasets 

c) Create new Templates 

d) Create new Quefax databases 

e) Creating Interface Workbooks for controlling Quefax behavior 

f) Archive datasets 

1.8  Create a new Quefax compatible computer 
Creating a Quefax compatible computer means 2 things: (i) update your computer so that (ii) Quefax can 

install properly. 

Updating Computer 

Quefax has been tested on a computer that has the following settings:- 

 Microsoft Windows XP Professional, with Service Pack 2 

 Microsoft Office 2003 and 2007  

Use the Control panel to check your Windows settings. Figure 3 shows a typical result. You may need to 

update your computer if your settings are different.   

 
Figure 3: Windows Settings 

From the Start/All programs menu click Windows Update. Then follow the wizards that follow. 

 

The settings for Microsoft Word 2003 that has used to test Quefax are shown in the following figure. 

 
Quefax was also runs in the Office 2007; the detailed steps and menus in this documentation refer more 

to this version than Office 2003. 
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Install Quefax 

Quefax is available as single zip file from ICRAF’s ftp site at 

ftp://www.worldagroforestry.org/anonymous/ResearchMethodsGroup/SSA CP/Quefax.zip 

Download to your computer; then install it using the following steps. 

1) Unzip the download to a folder called Quefax 

2) Setup the Logbook processor 

3) Add XML schema to Microsoft Word to the Schema Library  

Setting up Logbook processor 

Unzipping the Quefax.zip creates a folder structure that is similar to Figure 2. To start the Logbook 

setup, go to the Logbook subfolder and run the setup program. Then follow the wizards to the end. 

Most setup problems are solved by updating your Windows system 

 

Adding Quefax schemas to the Schema Library 

Quefax has one schema called questionnaire.xsd that is used for turning word forms into data entry 

templates. To be useful, you need to add it to the Schema library. 

To add Schemas to the Schema Library, do the following: 

1) On the Developer tab, in the XML group, click Schema.  

 NOTE    To display the Developer tab, do the following: Click the Microsoft Office Button , and then 

click Word Options. Click Popular, and then under Top options for working with Word, select the Show 

Developer tab in the Ribbon check box. 

2) Click Add Schema, browse to the Quefax/templates/questionnaire.xsd file, and then click Open.  

3) In the Schema Settings dialog box, select the options that you want, and type a name, say 

questionnaire, for the Schema in the Alias box.  

 NOTE    The name that you type for the alias appears in the list of available Schemas in the Templates and 

Add-ins dialog box. 

4) Click OK to finish. 

 

 

  

ftp://www.worldagroforestry.org/anonymous/ResearchMethodsGroup/SSA-CP/Quefax.zip
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1.9  Create a new Dataset  folder 

Quefax defines a dataset as all those files that are based on the same form document. The structure of a 

dataset folder has two sub-folders: e-forms and work. The e-forms folder is used for saving electronic 

forms after they are filled in with data.  The work folder is used for holding all other working files 

associated with the dataset. The starting form document should be copied to this folder 

1.10   Create a new Template 

Templates are very central to Quefax. To create a new one, from an existing document, do the 

following:- 

i. Insert Form Fields 

ii. Add XML tags 

iii. Add the attribute names 

iv. Update file properties 

v. Protect the document and save it 

Insert Form Fields 
Form fields allow data entry on electronic forms. Starting from an existing document (see 

<Quefax>/sample datasets/registration for participants.doc ) do the following:- 

Double click on each line (needed for writing responses on the paper form) to select it and replace it 

with a form field. How? 

a. Select Developer tab. 

b. From the Controls group click on Legacy Tools.  

c. From Legacy forms select Text Form Field. 

The samples in Box 1 and 2 show the sample document before and after inserting the Text Form Fields.  

Box 1: Document before inserting Text Form Fields 

Form No. 1: Registration for Workshop Participants 

 

1. Name: _________________________________ 

2. Contact address: ___________________________ 

3. E-mail: ________________________________ 

4. What is your current position? _____________________________ 

5. What is your relationship to the SSA CP? ____________________________ 

6. How familiar are you with MS Access?  1=Not familiar, 2=Familiar, 3=Very familiar 
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Box 2: Document after replacing response markers with Text Form Fields 

Microsoft Word has many controls: drop down list boxes, combo boxes, radio buttons etc, but the 

present version of Quefax works only with the simple Text Form Field. This is because we found it 

difficult to extract data captured by controls, other than Text Form Field, after we convert the Word 

document into an XML document.  

Add XML Tags 

The Quefax XML tags are used for carrying the data that is needed for (a) generating a relational 

database and (b) supporting the transfer of data from a filled in e-form to the database  

Before you can add the Quefax XML tags, you first attach questionnaire schema, then use it to add the 

tags to the document  

Attach a Schema to a document 

After there are Schemas in the Schema Library, you can attach a Schema to a document. 

1. Open your document in Word.  

2. On the Developer tab, in the XML group, click Schema.  

3. In the Checked schemas are currently attached box, select the check box for Questionnaire schema. 

 

Add XML tags 

1. In your document, highlight the content that you want to tag.  

You can select a word, phrase, paragraph, cell, row, column, field, picture, or object in the document. 

2. In the XML Structure task pane, in the Choose an element to apply to your current selection list, select 

an element. 

 NOTE    To limit your choices of elements and attributes, select the List only child elements of current 

element check box. 

Form No. 1: Registration for Workshop Participants 

 

1. Name:       

2. Contact address:       

3. E-mail:       

4. What is your current position?       

5. What is your relationship to the SSA CP?       

6. How familiar are you with MS Access?       1=Not familiar, 2=Familiar, 3=Very familiar 
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3. If necessary, specify an attribute for the element.  

How? 

a. In the XML Structure task pane, under Elements in the document, right-click the 

element, and then click Attributes.  

b. In the Available attributes list, select the attribute that you want.  

c. In the Value box, type the value of the attribute.  

d. Click Add. 

A formal description of Quefax XML elements is covered in Appendix 1.13 

Add the attribute names  

To add the attribute for the variables you right click on it and select attributes.You are prompted with a 

attributes for variable dialog box, then type in the appropriate name and add. This names will be 

translated into the tables field name in the Quefax databse; hence basic rules for naming conventions 

should be adhered to which include; 

1. Avoid the use of upper case. 

2. Avoid using spaces between two or more names. 

3. Use short names (in most cases at most eight characters). 

4. Do not use symbols such as %, &, #, ’’, etc. 

5. Use names that summarize the whole variable. 

Update File Properties  
File properties are useful for data management if used in a structured way. Quefax use them for (a) 

systematizing filenames for e-forms, (b) grouping related data and (c) indicating to the Logbook 

processor if a document is an e-form or not. To use them, you first need to access them, then to modify 

them appropriately. 

Accessing file properties 

To access the file properties before a Word 2007 document is saved do the following 

1. Click the Microsoft Office Button , point to Prepare, and then click Properties. 

2. In the Document Information Panel, type the information that you want in each of the property field boxes. 

See the example below. 

javascript:ToggleDiv('divExpCollAsst_IDAHV23C')
javascript:ToggleDiv('divExpCollAsst_IDAHV23C')
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Modifying file properties 

The following table shows how Quefax uses the standard file properties 

Name of file 
property 

Quefax uses it for… Example 

Title Systematizing file names for e-forms based on this template. 
When a document from this template is saved, the Save As dialog 
box prompts the user with the Title. You complete the file name 
by specifying values in the space marked xxx 

Household xxx 

Subject Grouping all e-forms of the same project together. Choose a 
short code as a unique project identifier 

SSA CP 

Author Linking back to the person who can provide further data about 
the Template. Start with surname, followed by initials and use 
the comma as a separator for multiple authors. 

Masson C., Njuki J. 

Category Indicating that the e-form contains data of the described type Data/household 
survey 

Keyword Indicating that the document is an electronic form with xml 
markers already added 

xml-tagged-
questionnaire 

Comments Capturing other properties, using the following syntax:- 

<property1>:<item11>, <item12;  <property2>:<item21>,<item22> 

Where <property> refers to the x’th property name. A property can be 
associated with more than one value; <itemxj> refers to the j’th one. 
The comma is used for separating out the items for a property, and a 
semicolon is used between properties. 

Year:2008; 
location:Kivu 

 

Filling in file properties is important for data archiving. The metadata captured in these properties are 

useful for building catalogs for searching data in a large archive. 

Protect & Save Document 

If you want users to be able to edit the data in an XML document without editing or deleting the XML tags, you can 

use the document protection feature to make only the content of the XML elements available for editing, and not the 

tags themselves. 



 

 21 

Q
u

ef
ax

: A
 R

es
ea

rc
h

 D
at

a 
M

an
ag

em
en

t 
Sy

st
em

 |
 7

/1
/2

0
1

0
  

1. In the XML Structure task pane, select the Show XML tags in the document check box.  

2. On the Developer tab, in the Protect group, click Protect Document and select Restrict Formatting and 

Editing.  

3. In the Protect Document task pane, select the Allow only this type of editing in the document check 

box, and then select Filling in forms.  

4. Click Yes, Start Enforcing Protection. 

5. To assign a password to help prevent the accidental removal of the document protection, type a password 

in the Enter new password (optional) box, and then confirm the password.  

After the form document is protected, you save it as a template, in the <dataset>/template folder, 

where <dataset> is the name you selected for the dataset based on this form. 

1.11  Create a new Database  
Use the following steps to create a Quefax compliant database:- 

1. Get a Quefax database template. 

2. Load database schema  

3. Generate database tables 

Get a Quefax database template 

The database template has pre-installed tables and queries that are important for supporting the 

creation of a Quefax compliant database. They are normally hidden from the user to prevent accidental 

deletion. This is one of the templates copied to your computer after a successful installation of Quefax. 

You need to copy it from <Quefax>\templates\startup database.mdb to your <dataset folder>\work 

folder. We recommend that you give it the same name as your dataset (and of course the .mdb 

extension). The current version of Quefax does not work with newer .accdb files.  

 

Load database schema 

This step uses the XML tags in the newly constructed form template and populates the database with 

the data for adding new tables. To execute it, take the following steps:- 

1. Open the database  

2. Open the form template 

3. Call the Logbook Assistant 

4. Click the UpdateDB menu 

5. Click the Using schema in current e-form menu 

 

Generate tables 
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Once the database schema has been read, the next task is to use it to generate the necessary tables and 

their relationships. With the Logbook Assistant still locked to the database, do the following. 

 

1. Click on the Efficiency menu 

2. Click on Create tables from uploaded schema menu 

3. After the Logbook Assistant returns with an Ok message, close it 

4. Press F5 function key to refresh the Tables window in MS Access. 

 

After the last step, you should see the newly added tables. To see the relationships between the parent 

and child tables in MS Access do the following. 

1. Click on the Design Tab 

2. In the Relationships group click All Relationships 

 

You should now see a result similar to figure  

 
Figure 4: Tables and their relationships generated automatically from e-forms. Household is the parent 

table. The others are child tables. 

 

1.12  Modify the Interface Workbook for Batch Loading 
An interface workbook is an Excel Workbook that is used to provide the Logbook Assistant with different 

parameter values to control its behavior. For instance, there are 2 parameters that need to be modified 

to suit your conditions for loading e-forms in a batch 

(a) The physical locations of your e-forms 
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(b)  The password used for protesting the original template 

To do these modifications, do the following. 

1. Copy <Quefax>/templates/Batch loading of e-forms.xls file to your working directory, say 

<dataset folder>/work 

2. Go to the Data source sheet 

3. Type the path to the location for e-forms. The most preferred way is to copy and paste under 

root_name the full path from the Address bar; this is likely to reduce incidence of making errors. 

Note: If the e-forms are located in more than one folder, use this sheet to specify as many of them as 

you need. Enter yes in the root_isvalid column for all those folders with data to be uploaded otherwise 

enter no in the same column for all any sub-folders that don’t contain e-forms of interest(not for 

uploading). 

4. Go to the Options sheet 

5. Enter the password that was used for protecting the e-forms in the indicated cell. 

Note: The Logbook Assistant needs the password for unlocking the e-forms; otherwise it cannot access 

the XML tags (when it needs them) 

The rest of the worksheets should not be modified.  

5. References 

6. Appendices 

1.13  Quefax Optimization System  
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Figure 

1.14  Quefax Questionnaire Schema  
The Quefax XML elements and their relationships are shown in Figure 5 

Questionnaire

Table

Number

Field

Title

Assessment

Id RowsColumns

Value

Id

Variable

Name

Name

Name

Name Identification

 

Figure 5: Quefax XML elements. The green shaded boxes represent important attributes 
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 The following table shows the relationship between the structure of the database (as described in 

section 1.5) and that of the Quefax XML elements 

XML Element Parent 
elements 

Child elements Purpose and Attributes 

Assessment Questionnaire Assessment, 
Table, Field 

This element is useful for extracting the 
hierarchical structure of a form into a Quefax 
database.   

Columns Table One or more 
variables 

Container for variables that for the field 
names of a child table.   

Field Questionnaire Both of the 
Variable, Value 

Container for a variable and its value  

Id Questionnaire, 
Table, Variable, 
Assessment 

Number, Title Contains numberings and associated texts 
that are used for describing various database 
components 

Number Id  Container for text used for numbering 
questions on a form  

Questionnaire This is the root 
element of the 
Quefax schema 

One of the 
following Field, 
Table, 
Assessment, 
Variable occurs 
one or more 
times 

Attribute Name: corresponds the name of the 
parent database table  

Table Questionnaire Id, Columns, 
Row 

Corresponds to a child table 

Name attribute: corresponds to the name of 
child table 

Title Id  Container of text used for describing database 
elements  

Value Field   

Variable Field, Table Id Name (required): Corresponds to the name of 
a field. If the parent is Questionnaire, then 
this is the name of a field in the parent table; 
if it is Table, then it’s the name of a child 
table. 

Type:  data type of the field. Possible values 
are text, memo and numeric. Text fields have 
a length of 255 characters.  The memo type is 
used when the length exceeds this value 

Fixed: means that the values associated with 
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the variable are not entered by the user, 
rather they are part of the e-form. This is 
useful for determining truly empty records 

 

1.15  The Structure of the Logbook Error Log  

The Logbook Error log file is an XML document with a root node called report.  See the example below. 

 

Figure 6: The structure of the Logbook Error Log File 

 There is only one child node, called file, under report that occurs one or more times. In the context of 

batch loading, there will be as many occurrences of the file as there are e-forms being uploaded. The file 

node has two attributes: one showing the full path of the e-form being uploaded, the other is a 

sequential counter used for monitoring progress. 

file has two child nodes: populate and error. The contents of populate is the time it takes to upload an 

e-form. This information was used monitor Quefax performance during development. 

The error node is more important for data managers; its content is the reported error message for 

further follow up. 

If the batch loading completes successfully, the error log is a well-formed document. However, if the 

process is stopped forcefully, for example, using the Windows Task manager, some nodes may not be 

closed properly. You may need to use Notepad to insert the missing closing tags. 

 

 


